
yesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyes
yesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyes
yesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyes
yesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyesyes

yesyesyesyesyesyesyesyes yesyesyesyesMain Contents



Vised help contents
Select an item from the list below to see the contents for that section.

Vised Basicis

Starting and exiting Vised, accessing 
menu commands, getting help, and 
definitions

Workplace

Fonts, keyboard, toolbar, status bar, 
scrolling, Vised windows, and menu

Editor

Working with documents, entering and 
editing data, working with sequences

Sequence analysis

Vised sequence analysis functions

Dialog boxes

Vised dialog box help

Information

Registration, distrubution, credits, about
Vised (version info etc)



Definitions
Clipboard
Current sequence
Current position
Cursor

Editor window

Insert mode
Insertion point

Landscape

Menu

Overtype mode

Non-scrolling position line

Path

Scroll bar
Sequence block
Sequence name
Sequence number
Sequence type
Status bar

Title bar
Toolbar



Insert mode
An option for inserting typed characters into a sequence by moving existing characters down
stream. You can select the insertion mode by pressing the INS key. When you select the 
Insert option, the letters "INS" appear in the status bar at the bottom of the Vised window.



Sequence name
The Sequence name appears to the left of each line of sequence data.    When you import a 
sequence from a disk file, the file name is used as a sequence name.



Sequence number
The sequence number appears to the left of the sequence name, and indicates the position 
of the sequence in the editor.



Sequence type
One letter code to the left ot the sequence name indicating the sequence type.    Sequence 
types may be 'N' for nucleic acids, 'P' for proteins, 'A' for alignment or 'U' for unassigned.



Caret
The caret is the flashing vertical line that indicates the current insertion point.



Cursor
The cursor is the mouse pointer.    Its shape depends on where on the screen the pointer is 
located.    For example, in the menu bar, the cursor is an arrow .    In the document window 
the cursor is an I-beam 



Current sequence
The sequence that is currently active is the sequence that contains the caret.    All Vised 
commands that apply to individual sequences are applied to the current sequence.    The 
number of the current sequence is indicated on the Status bar after "Seq".



Current position
The current position is the position in the current sequence where the caret is located, and is
the position where data is inserted.    Many Vised commands that apply to individual 
sequences are applied at the current position.    The current position number is indicated on 
the Status bar after "Pos".



Editor window
The window containing open sequences in an editor document.    Note that you cannot close 
the editor window.



Insertion point
Vertical blinking bar on the Vised screen that shows your current location and where data 
are inserted. The insertion point also determines where Vised will begin an action, such as 
translation or removing spaces.



Landscape
A term used to refer to horizontal page orientation; opposite of "portrait," or vertical, 
orientation.

Landscape

Portrait



Non-scrolling position line
The Non-scrolling position line is a position line displayed at the bottom of the screen.    It is 
primarily used to indicate what positions are on screen when there are too many sequences 
open to fit on the screen.



Overtype mode
An option for replacing existing characters one by one as you type. You can select overtype 
by pressing the INS key. When you select the Overtype option, the letters "OVR" appear in 
the status bar at the bottom of the Vised window.



Path
Drive, directory, and filename. For example, the complete path for Vised might be C:\VISED\
VISED.EXE.



Scroll bar
A graphical device for moving vertically and horizontally through a document with a mouse. 
Scroll bars are located at the right and bottom edges of the document window. You can 
display or hide scroll bars with the Horizontal Scroll Bar and Vertical Scroll Bar check boxes in
the Options dialog box (Settings menu).



Sequence block
A veritical group of sequence lines.



Title bar
The horizontal bar at the top of a window that shows the name of the document or 
application that appears in that window.



Toolbar
A bar containing buttons that perform some of the most common commands in Vised, such 
as opening, saving, and printing files.    To display the Toolbar, select the Toolbar check box 
from options dialog box (Settings menu). You may need to enlarge the Vised window to the 
full width of the screen to see the entire Toolbar.



Statusbar
A line at the bottom of the Vised window that displays information about the current status 
of the document.



Menu
A list of commands that drops down from the menu bar. The menu bar is displayed across 
the top of the Vised window and lists the menu names, such as File and Edit.



Clipboard
A temporary storage area for cut or copied text or graphics. You can paste the contents of 
the Clipboard into any Vised sequence or into a file of another application, such as a word 
processor. The Clipboard holds the information until you cut or copy another piece of text.



Vised Basicis
Starting Vised
Exiting Vised
Accessing menu commands
Getting help
Definitions



Getting help
To view the Vised Help File from the editor, select 'Contents' from the Help Menu.    To search 
help topics, select 'Index' from the Help Menu.    To learn how to use Help, select 'Help on 
Help' from the Help Menu.

To get help within dialog boxes, click on the Help button.

Shortcut:
 Press the 'Help' icon on the tool bar.
 Press F1.



Accessing menu commands
Menu commands can be accessed with the mouse or with the keyboard.

 Mouse:
To access the menu with a mouse, position the pointer on the desired menu item and click 
the left mouse button once.    Items from drop down menus are selected in the same way.

 Keyboard:
To access the menu using the keyboard, press ALT and the underlined letter in the menu 
item name.    For example, to access the File menu, press ALT-F.    To select an item in a drop 
down menu, press the letter that is underlined in the item name, or use the arrow keys to 
select the desired item and then press ENTER.

Many menu commands have keyboard shortcuts.    When this is the case, the keystrokes are 
indicated beside the menu item in the dropdown menu.

______________
Related topics:
Menu
Keyboard



Exiting Vised

When you exit Vised, you will be prompted to save any changes you have made to Vised 
documents
To exit:
You can exit Vised through the Vised menu or the system menu, or by using a keyboard 
shortcut.
To exit Vised through the menu:
    1.    Select the File menu with the mouse or by typing ALT-F
    2.    Select exit from the File Menu with the mouse, or by typing X

To exit through the system menu:    Double click on the system menu box at the upper 
left hand corner of the main Vised Window.

To exit using the keyboard shortcut:,    Type ALT-F4



Starting Vised
You can start Vised from either Windows or the command prompt:

From the program manager:
To start Vised from the Windows Program Manager

    1.    Switch to the Program Manager window.
    2.    Open the group window that contains the Vised icon.
    3.    Do one of the following:

Double-click the Vised icon.
Use the arrow keys to select the Vised icon, and then press ENTER.

From the windows file menu
To start Vised from the Windows File menu

    1.    From the Program Manager File menu, choose Run.
    2.    Do one of the following:

If Vised is in your path, type Vised
If Vised is not in your path, type the path for Vised -- for example:
c:\Vised\Vised.exe

    3.    Choose the OK button.

From the DOS Command prompt
To start Vised from the command prompt

    1.    At the command prompt, type win Vised
    2.    Press ENTER.

Note: If a message appears stating that the command failed, the directory
containing Vised is not on your path. Change to the directory containing
VISED.EXE and try again.



Workplace
Menu
Editor toolbar
Pretty display    tool bar
Moving the insertion point
Scrolling through the editor
Status bar
Vised windows
Keyboard
Selecting fonts



Menu

The menu bar is located below the aplication title bar, along the top of the main window.    All
Vised commands can be acessed through the menu bar.

To view all the commands in a menu, do one of the following:

 Click the menu name.
 Press ALT+n, where n is the underlined letter in the menu name. For example, press ALT+F

to open the File menu.

Menu bar items:
File menu
Edit menu
Sequence menu
Options menu
Window menu
Help menu

______________
Related topics:
Accessing menu commands



File menu

Commands For Manipulating Files: Create, Open, Print And Save Files, And Exit.
New Document

Creates An New Vised Document.    All All Sequences In The Editor Window Are Discarded.
You Will Be Prompted To Save Changes, If Any.

Open Document
Opens An Vised Document That Has Already Been Saved To A Disk File.    Calls The Open 
File Dialog Box.

Save Document
Saves The Active Vised Document To A Disk.    Calls The Save As Dialog Box.    To Save 
The File Under Its Original Name, Just Press Enter.    If You Want To Save The File Under A 
New Name, Enter The Name In The File Name Edit Box Before You Press Enter.

Print Document
Prints the Editor Window.    Calls The Print Dialogbox.

Print Pretty Display
Prints The Contents of the Pretty display Window.

Exit
Exits Vised.    You Will Be Prompted To Save Documents That Have Been Changed Before 
Exiting.

Recent File List
A List Of The Last Four Files Saved Is Displayed At The Bottom Of The File Menu.    
Selecting Any One Of These Files Causes That File To Be Opened.



Edit menu

Commands for editing: undo, cut, copy, paste, convert to upper or lower case, insert or 
remove spaces, and search.
Undo

Undoes the last change made in the editor.
Cut

Deletes selected (highlighted) sequence data from the current sequence and copies it to 
the clipboard.

Copy
Copies selected (highlighted) sequence data from the current sequence from the edit 
window, or a selection from the pretty display window, to the clipboard.

Paste
Copies information from the clipboard into the current sequence.    If sequence data is 
selected, Paste overwrites the selection with the data in the clipboard.    Otherwise, the 
data is inserted at the current position.

Remove spaces
Removes spaces deletes blanks from a sequence.    If sequence data is selected, spaces 
are removed from the selection only.    Otherwise, spaces are removed from the current 
position to the end of the sequence.

Insert spaces
Inserts a specified number of spaces at a given interval.    Calls the Insert Spaces dialog 
box.    If sequence data is selected, spaces are inserted into the selection only.    
Otherwise, spaces are inserted from the current position to the end of the sequence.

Delete to end of seq
Deletes the sequence from the current position to the end of the sequence.

Upper case
Convert data to upper case characters

Lower case
Convert data to lower case characters

Find
Searches the current sequence for the next occurance of a text string.    Calls the Find 
dialog box.

Seacrh again
Repeats the last find operation.



Sequence menu

The Sequence menu contains commands that apply to both nucleotide (type N) and protein 
(Type P) sequences.
Create

Generates an empty sequence.    If too many sequences are already open, or if there is 
insufficient memory to create the sequence, an error message is displayed.

Import
Opens formated sequence file that has already been saved to a disk.    Calls the Import 
dialog box.    See Importing a sequence for supported formats.

Export
Saves the current sequence to a disk file.    Calls the Export dialog box.

Delete
Deletes the current sequence.    You will be prompted to save the sequence and given an 
opportunity to cancel the command.

Reverse
Causes a sequence to be written out the reverse orientation.    This command does not 
create a new sequence.

Complement
Creates a new sequence that is the complement of the current sequence.

Translate in frame
Creates a new sequence that is the translation product of the current sequence.

Translate all
Translate the sequence in all six frames.

Match
Identifies identical posistions in a sequence with the sequence above.    If sequence data 
is selected, the match is applied to the selected portion of the sequence only.    
Otherwise, the match is applied from the current position to the end of the sequence.    
Note that the sequences must have be the same type.

Pretty display
Displays all open sequences for formatted output.

Pattern search
Search the current sequence for a pattern using the prosite data base pattern syntax.



Options menu

Commands to set options for analysis functions, editor, individual sequences, and fonts.
Editor options

Set editor options.
Pretty display opitons

Set options used for Pretty display.
Sequence options

Sets the sequence name, type and position, and Display mode numbering options for the
current sequence.    Calls the Sequence Info dialog box.

Title font
Set the font used in pretty display title.

Font
Set the font used in the editor and pretty display windows.



Window menu

Commands for manipulating Vised windows: tile, cascade, set active window.
Cascade

Arranges document windows in a cascaded format.
Tile

Arranges document windows in a tiled format.
Edit window

Brings the editor window to the foreground and makes it active.
Pretty display window

Brings the prettyt display window to the foreground and makes it active.



Help menu

Commands for displaying the help index, the help search dialog box, and the Vised About 
dialog box.
Contents

Displays the Vised Help File contents.
Search

Displays the Vised Help File Search dialog box.
Help on help

How to use help.
About Vised

Displays a copyright notice and information about Vised.



Editor toolbar
The tool bar is a collection of buttons displayed under the menu bar that you can use to 
accomplish common tasks quickly.    To use the tool bar, position the mouse cursor over the 
desired button and click the left mouse button.

Vised displays two tool bars, an editor tool bar that is displayed when the editor window is 
active, and a graph/data tool bar that is displayed when the graph or data window is active:
Editor tool bar
This tool bar is displayed when the editor window is active

Create file
Creates a new Vised file by clearing all currently open sequences.

Open file
Open an Vised file from a disk.

Save file
Save an Vised file to a disk.

Print file
Print the contents of the Editor window

Create sequence
Create a new blank sequence.

Import sequence
Import a sequence from a disk file.

Export sequence
Export a sequence to a disk file.

Delete sequence
Delete the current sequence.

Cut
Delete highlighted data from the current sequence and copy the data to the 
clipboard.

Copy
Copy highlighted data to the clipboard.

Paste
Insert data from the clipboard into the current position.

Undo
Undo the most recent edit.



Top of 1st sequence
Move the insertion point to position one of the first sequence.

Top of the current sequence
Move the insertion point to postion one of the current sequence.

End of the current sequence
Move the insertion point to the last position of the current sequence.

End of the largest sequence
Move the insertion point to the last position of the largest sequence.

Help
Veiw the help file contents.



Pretty display tool bar

This tool bar is displayed when the pretty display window is active.

Print
Print the contents of the active window.
Save
Save table or graph/map as picture
Options
Set analysis function options.
Font
Set the font for the current window.
Help
View the help file contents.



Moving the insertion point
To change the current position or current sequence, you must move the insertion point, 
which is shown by the caret.    You can move the caret using the keyboard or the mouse.    
You can also scroll through the editor window without moving the current position.
To set the current position:

 With the mouse:
1.    Scroll to the desired location
2.    Position the cursor over the desired sequence position
3.    Click the left mouse button once.    The caret will move to the new position.

 With the keyboard:
To move: Press:
One position down stream
One position up stream
Up one sequence
Down one sequence
Start of the current line HOME
End of the current line END
Start of the current 
sequence

CONTROL + HOME

End of the current sequence CONTROL + END
Start of the 1st sequence CONTROL + PAGEDOWN
End of the largest sequence CONTROL + PAGEUP

______________
Related topics:
Scrolling through the editor



Scrolling through the editor

You can scroll through the editor window without changing the current positon using either 
the mouse or the keyboard.
To scroll through the editor

With the mouse:
Use the horizontal and vertical scroll bars, as illustrated below:

    With the keyboard:
To scroll: Press:
up by one screen PAGE UP
down by one screen PAGE DOWN

______________
Related topics:
Moving the insertion point



Status bar

The Status bar is located at the bottom of the Vised window.    When the menu is active, the 
status bar displays a message descibing what the selected menu command does.    
Otherwise, the contents of the status bar depend on what window is active.
Editor status bar
When the editor window is active, the status bar displays:

Current sequence
Indicates which of the sequences in the editor currently has the carret (the caret is 
the flashing vertical bar that indicates the inserion point).

Current position
Indicates the position of the caret in the current sequence.

Insertion mode
Indicates whether keystrokes will be inserted at the current position or will be typed 
over the existing data.

CAPS
Indicates the status of the caps lock key.    If the caps lock key is on, CAPS will be 
displayed.    Otherwise, this section will be blank.

Current genetic code
Indicates what genetic code is in use.    This may be either the standard genetic code 
or a user defined genetic code.



Vised windows
Vised displays either one or two windows at any given time:    the Editor window, and the 
pretty display window.    The Editor window is always open.    The pretty display window is 
shown when you select the pretty display function from the sequence menu..
Editor window

The editor window displays your sequence data    You will use the editor window to enter 
and edit data.    You will also use the editor as a launch pad for sequence analysis 
functions.    The editor window displays up to twenty sequences simultaneously, and also 
displays the sequence number, type and name.

Pretty display window
The pretty display window displays all of your sequences in user defined formats.    You 
cannot edit the data in the pretty display window.



Keyboard

Many commands can be executed more quickly using keyboard short cuts.    These are the 
key combinations you can press to execute menu commands. 

Control Key combinations:

Press: To:
Ctrl+N Create a new document
Ctrl+O Open an existing document from a disk file
Ctrl+S Save the active document
Ctlr+P Print the active document
Ctrl+X Cut the selected data
Ctrl+C Copy the selected data to the clipbord
Ctrl+V Paste data from the clipboard to the current position
Ctrl+A Create a new sequence
Ctrl+M Import a sequence from a disk file
Ctrl+E Export the current sequence to a disk file
Ctrl+D Delete the current sequence
Ctrl + Home Move to start of current sequence
Ctrl + End Move to end of current sequence
Ctrl + Pageup Move to start of first sequence
Ctrl + Pagedown Move to end of largest sequence
Alt+BackSpace Undo

Function Keys:

Key: Command:
F1 Help contents
Shift+F1 Help search

F2 Remove spaces
Shift+F2 Insert spaces

Ctrl+F3 Delete to end of sequence
F3 Find
Shift+F3 Find again

Alt+F4 Exit Vised

F5 Match
Ctrl+F5 Pattern search
Alt+F5 Pretty display

F7 Translate in frame
Shift+F7 Translate all



Alt+F7 Reverse
Ctrl+F7 Complement

F10 Pretty display options
Shift+F10 Sequence options
Alt+F10 Editor options

F11 Editor font
Ctrl+F11 Title font



Selecting fonts
To set the font used in the editor and pretty display windows, select 'Font' from the options 
menu.    To set the font used in the pretty display title, select 'Title font' from    the options 
menu.    Both of these commands call the font dialog box.

Note:    The editor and pretty display windows use fixed pitch fonts only.



Editor
Documents

Creating a document
Opening an existing document
Saving a document
Printing documents
Editor options

Editing
Undo
Entering data
Editing data
Selecting data
Cutting sequence data
Copying sequence data
Pasting sequence data
Deleting to the end of a sequence
Removing spaces from a sequence
Inserting spaces into a sequence
Finding text

Sequences
Creating a sequence
Importing a sequence
Exporting a sequence
Moving a sequence
Sequence options: name,    type, and number



Creating a document
To Create a new document:

Select "New document" from the file menu.    

Shortcut:

 Press the 'New document' icon on the tool bar.

Notes:

 If you have made changes to the current document, you will be prompted to save 
your work.
______________
Related topics:
Opening an existing document
Saving a document



Opening an existing document
To open an existing document, do the following:

 select 'Open' from the file menu.    This will open the File open dialog box
. 

 In the File Name box, type or select the document you want to open.

 If the document you want to open is not listed in the File Name box, do one or 
more of the following:

--In the Drives box, select a new drive.
--In the Directories box, select a new directory.
--In the List Files Of Type box, select the type of document you want to open with 

its 3-character extension.

 Choose the OK button.

Shortcuts:

 Press the 'Open' icon on the tool bar.

 If the document was recently saved, you can open it by selecting the file name 
from the recent file list in the file menu.

Notes:

Vised will automatically recognize and import Macaw files.

You can see a list of all the files with a specific extension in a drive or directory 
with a specific extension. In the File Name box, type an asterisk (*), before a period (.) and 
the extension. For example, to see all the files with a .DAT extension in a directory, type 
*.DAT in the File Name box. To see all the files in a directory, type *.*

______________



Related topics:
Creating a document
Saving a document
File open dialog box



Saving a document
To Save a document, do the following:

 select 'Save' from the file menu.    This will open the File save dialog box. 

 In the File Name box, type or select the document you want to Save.

 If the document you want to Save is not listed in the File Name box, do one or 
more of the following:

--In the Drives box, select a new drive.
--In the Directories box, select a new directory.
--In the List Files Of Type box, select the type of document you want to Save with 

its 3-character extension.

 Choose the OK button.

Shortcut:

 Press the 'Save' icon on the tool bar.

Notes:

You can see a list of all the files with a specific extension in a drive or directory 
with a specific extension. In the File Name box, type an asterisk (*), before a period (.) and 
the extension. For example, to see all the files with a .DAT extension in a directory, type 
*.DAT in the File Name box. To see all the files in a directory, type *.*

______________
Related topics:
Creating a document
Opening an existing document
File save dialog box



Printing documents
You can print the contents of the Editor and Pretty display windows.    The commands used to
print are:
Window Menu Command
Editor window File menu Print document
Pretty display window File menu Print pretty display

To print a file:
1. Select the appropriate print command from the File menu as listed in the above table.  
This will call the Print dialog box.
2. Select the desired numer of copies and print quality.
3. Press the Setup button if you wish to change the printer in use, or to set the paper 
size, source and orientation.    This will call the Print setup dialog box, shown below:
4. Press the OK button.

Cancelling a print job:
Printing takes place in two stages.    First the out put is sent to a print spooler, such as the
Print manager that comes with MS Windows.    Then the print spooler sends the output to 
the printer.

While Vised is sending its output to the spooler, the "printing file" message box is 
displayed .    You can cancel the job by pressing Cancel in the message box,.

Once the file acutally starts to print, you must use the print manager to cancel the 
job.



Editor options
You can set editor options to change the appearance of the editor, or to determine what 
genetic code is used in the translation of nucleic acid sequences.
The editor options are:

Line length:    Sets the number of characters displayed on each line.    The line 
length must be an even mutlple of 10, and may not be greater than 250.

Name field width:    Sets the number of characters displayed of the name of each
sequence.    The name field width may be any number bewteen 0 and 16.    If the name field 
width is less than the number of characters in the name of a sequence, the name is 
truncated.

Genetic code:    You may choose to use the standard genetic code, or a user 
defined genetic code to translate your Nucleic acid sequences.    You can edit the user 
defined genetic code by pressing the button labeled "Edit user defined code".

To set the editor options:
1. Select Editor options from the options menu.
2. Enter the desired options.
3. Press the OK button.

______________
Related topics:
Selecting fonts
Editor options dialog box



Creating a sequence
To Create a new sequence:

 select "Create" from the sequence menu.    

Shortcut:

 Press the 'Create sequence' icon on the tool bar.

Notes:

 The newly created sequence is type "U" (Unassigned).

 If there are too many sequences open, an error message is displayed (the 
maximum number of sequences is 30).
______________
Related topics:
Sequence options: name,    type, and number
Importing a sequence



Importing a sequence
Vised automatically detects and reads sequences in a variety of formats.    If the format is 
not recoginzed, Vised reads in the whole file, including information that may not be part of 
the sequence.    If this happens, you can remove the extraneous information using the editor.

Currently, Vised recognizes sequence data in the following formats:

DNAStrider NBRF
EMBL Olsen
Fitch Pearson/Fasta
GCG PIR/CODATA
GenBank/GB Plain/Raw
IG/Stanford Zuker

To import an existing sequence:

 select 'Import' from the sequence menu.    This will open the Import Ascii File 
dialog box. 

 In the File Name box, type or select the sequence you want to import.

 If the sequence you want to import is not listed in the File Name box, do one or 
more of the following:

--In the Drives box, select a new drive.
--In the Directories box, select a new directory.
--In the List Files Of Type box, select the type of file you want to open with its 3-

character extension.

 Choose the OK button.

Shortcut:

 Press the 'Import' icon on the tool bar.

Notes:

You can see a list of all the files with a specific extension in a drive or directory 



with a specific extension. In the File Name box, type an asterisk (*), before a period (.) and 
the extension. For example, to see all the files with a .DAT extension in a directory, type 
*.DAT in the File Name box. To see all the files in a directory, type *.*

If the file name specifies a library (a file that contains more than one sequence), 
the Select sequence dialog box will be called.    This dialog box alows you to select which 
sequence you wish to import from the library.    Note that this alows you to import individual 
sequences from Vised files, as well as sequences from libraries in any of the formats listed 
above.

______________
Related topics:
Creating a sequence
File open dialog box
Select sequence dialog box.



Exporting a sequence
To Export a sequence:

 select 'Export' from the sequence menu.    This will open the Export Ascii File 
dialog box. 

 In the File Name box, type or select the sequence you want to Export.

 If the sequence you want to Export is not listed in the File Name box, do one or 
more of the following:

--In the Drives box, select a new drive.
--In the Directories box, select a new directory.
--In the File format box, select the sequence format you want.
    Supported formats are:

DNAStrider NBRF
EMBL IG/Stanford
Fitch Pearson/Fasta
GCG PIR/CODATA
GenBank/GB Plain/Raw

 Choose the OK button.

Shortcut:

 Press the 'Export' icon on the tool bar.

Notes:

You can see a list of all the files with a specific extension in a drive or directory 
with a specific extension. In the File Name box, type an asterisk (*), before a period (.) and 
the extension. For example, to see all the files with a .DAT extension in a directory, type 
*.DAT in the File Name box. To see all the files in a directory, type *.*

______________
Related topics:
File save dialog box





Moving a sequence
The sequence postion is indicated by a number to the right of the sequence name in Edit 
Mode.
To change the sequence order:

 Open the Sequence Info dialog box by selecting 'Sequence Options' from the 
sequence menu or by double clicking on the name field of the sequence you wish to move.

 Enter a new position for the sequence in the Number edit box to the left of the 
sequence name.
Shortcut:

 Use the mouse to click on the name field of the sequence you wish to move and 
drag it to the new position.    A black box will appear around the sequence that is being 
moved, as shown below:

______________
Related topics:
Sequence options: name,    type, and number
Sequence options dialog box



Sequence options: name, type, and number

Options for each sequence are:

Name:    The sequence name can be any combination of characters, up to 16 
characters total.    When you import a sequence from a disk file, the file name is 
automatically used as the seqence name.

Type:    Sequences may be type 'N' for nucleic acids, 'P' for protein, 'A' for 
alignment, or 'U' for unclassified.    The sequence analysis fuctions available for a given 
sequence depend on the sequence type.

Number:    This option specifies the position of the sequence in the editor.    For 
example, entering a 3 in this edit field will cause the sequence to be moved to the third 
position.    Note that the number you enter must not be greater than the total number of 
sequences open.
To set the options for a given sequence: 

1. Position the caret in the sequence whose option you wish to change
2. Select Sequence options from the options menu
3. Enter the desired options in the sequence options dialog box.
4. Press the OK button.

Short cut:    Position the cursor over the sequence name or number and Double click the 
mouse left button to call the sequence options dialog box.



Undo
You can undo an error in the editor using the Undo command in the edit menu.    This 
command reverses the most recent edit.

To undo the most recent edit: 
Select undo from the edit menu

shortcuts:

      Press Alt+Backspace.

Press the undo button on the toolbar



Entering data

When you start Vised, a single type 'N' sequence is created, and the insertion point, or caret,
is positioned at position 1, ready to receive your typed data.
To enter sequence data from the key board, position the caret within the desired sequence.    
Data can be entered from the keyboard in either insert mode or typeover mode:
Insert mode:    Keystrokes are inserted into the sequence at the current position, and the 
characters downstream from the current position are moved to the right to make room for 
the insertion.
Typeover mode:    Typed characters displace the characters already present.
Notes:

If any data is highligted, typing replaces the highlighted data regardless of 
insertion mode.

You cannot enter data after the end of sequence marker.    If you attempt to do so, 
an error message will be displayed.
______________
Related topics:
Editing data
Selecting data



Selecting data

Selected (highlighted) data appears as white characters on a black background.    You can 
select data using the mouse or the keyboard.

 With the mouse:
To select part of the sequence:
1. Place the cursor over the desired selection start point.
2. Click the left mouse button and hold it down.
3. Drag the cursor to the desired end point.
Note: If you drag the mouse outside of the editor window, the window will be scrolled.
To select all of a sequence:
1. Place the cursor over the desired sequence.
2. Double click the left button.

 With the keyboard:
1. Position the caret at the point where you wish the selection to begin.
2. Hold down the shift key, and press the arrow keys to extend the selection in the 
desired direction.



Editing data

Data may be cut, copied, pasted or deleted, just as text is in a word processor.    You can also
use the commands in the edit menu to remove or insert spaces in the sequence, convert the
sequence to upper or lower case, or delete to the end of the sequence.    If you make an 
error when editing your data, immediately select undo from the edit menu, or press the 
undo icon on the toolbar.
Note:    You cannot edit beyond the end of sequence marker.    If you try to do so, an error 
message will be displayed.
For step by step instructions on specific editing tasks, view the help topics listed below:
Undo
Entering data
Selecting data
Cutting sequence data
Copying sequence data
Pasting sequence data
Deleting to the end of a sequence
Removing spaces from a sequence
Inserting spaces into a sequence



Cutting sequence data
To cut data from the current sequence use the mouse to select the data that you wish to cut.
Then select 'Cut' from the edit menu.

Shortcut:

 Press the 'Cut' icon on the tool bar.

Note:

 If no data is selected, the 'Cut' command in the edit menu is disabled (grayed)
______________
Related topics:
Selecting data
Copying sequence data
Pasting sequence data



Copying sequence data
To copy data to the clipboard:

1. Use the mouse to select the data that you wish to copy.
2. Then select 'Copy' from the edit menu.

Shortcut:

 Press the 'Copy' icon on the tool bar.

Note:

 If no data is selected, the 'Copy' command in the edit menu is disabled (grayed)
______________
Related topics:
Selecting data
Cutting sequence data
Pasting sequence data



Pasting sequence data
To paste data from the clipboard into a sequence:

1. Position the caret at the point in the sequence where you would like to insert the data.
2. Select 'Paste' from the edit menu

Shortcut:

 Press the 'Paste' icon on the toolbar.
Notes:

 If no data in the target sequence is selected (highlighted), pasting will cause the 
data in the clipboard to be inserted into the sequence at the current position.

 If data in the target sequence is selected, pasting will cause the data in the 
clipboard to replace the highlighted data.

 If the clipboard is empty, the 'Paste' comand in the edit menu is disabled (grayed).
______________
Related topics:
Selecting data
Cutting sequence data
Copying sequence data



Deleting to the end of a sequence
To delete to the end of a sequence:

1. Position the caret at the point you wish to delete from.
2. Select 'Delete to end of seq' from the edit menu.

Note:

 If the caret is positioned beyond the end of the sequence, an error message is 
displayed.



Removing spaces from a sequence
To remove spaces from a sequence:

1. Position the caret at the point in the sequence where you want the removal of spaces 
to start.
2. Select 'Remove spaces' from the edit menu.

Notes:

 If no data is selected (highlighted), spaces will be removed from the current 
position to the end of the sequence.    Spaces located at positions upstream from the current 
position will not be removed.

 If data is selected, spaces will be removed from the highlighted portion of the 
sequence.    Spaces will not be removed from the unhighlighted portions of the sequence.
______________
Related topics:
Selecting data



Inserting spaces into a sequence
To insert spaces into a sequence:

1. Position the caret at the point in the sequence where you want the insertion of spaces 
to start.
2. Select 'Insert spaces' from the edit menu.
3. Enter the frequency of insertion and the number of spaces to insert in the Insert 
spaces dialog box.
4. Press the OK button.

Notes:

 If no data is selected (highlighted), spaces will be inserted from the current 
position to the end of the sequence.    Spaces will not be inserted at positions upstream from 
the current position.

 If data is selected, spaces will be inserted into the highlighted portion of the 
sequence only.    Spaces will not be inserted into the unhighlighted portions of the sequence.
______________
Related topics:
Selecting data
Insert spaces dialog box.



Finding text
You can search your sequence data for short substrings as follows:

1. Position the caret at the point where you wish to search from.
2. Select Find from the edit menu.    This will call the Find dialog box.
3. Enter the desired string in the 'Find what' field.
4. Select the 'Match case' and 'Search up' or 'Search down' options as desired.
4. Press the OK button.

Notes

If the string is found in the data, the editor will scroll to the position of the string, 
and the string will be selected.

To repeat a search without using the Find dialog box, select Search again from the 
edit menu, or press Shift+F3



Sequence analysis
Reverse
Complement
Translate in frame
Translate all
Match
Pretty display
Pattern Search



Reverse
Reversing causes a sequence to be written out backwards.

To reverse a sequence:
1. Position the caret in the sequence you wish to reverse.
2. Select 'Reverse' from the sequence menu.

Note:

 Only nucleotide sequences (type 'N') can be reversed.    Reversing other sequence 
types causes an error message to be displayed.

______________
Related topics:
Sequence options: name, type, and number



Complement
Creates a new sequence that is the complement of the current sequence.

To complement a sequence:
1. Position the caret in the sequence you wish to complement.
2. Select 'Complement' from the sequence menu.

Notes:

 Only nucleotide sequences (type 'N') can be reversed.    Complementing other 
sequence types causes an error message to be displayed.

 Only the nucleotides A, G, T, C, U, R and Y are complemented.    All other 
characters are copied into the new sequence without change.

 If no data in the current sequence is selected, complementation begins at the 
current position and continues to the end of the sequence.

 If data in the current sequence is selected, complementation extends along the 
length of the selection only.

 If there are too many sequences open to create the new sequence, an error 
message is displayed.



Translate in frame

Translate in frame predicts an amino acid sequence in the reading frame starting at the 
current position, or at the begining of the current selection.    The function creates a new 
protein sequence, containing the translation product shown below the translated sequence.
To translate in frame:

1. Position the caret in the sequence you wish to translate.
2. Select 'Translate in frame' from the sequence menu.

Setting the genetic code:
You may choose to use the universal genetic code or a user defined genetic code that you 
can edit.    To set genetic code options, select Editor options from the Options menu, then 
choose from the following:

Universal: Use the standard genetic code

User defined: Use the user defined genetic code.

Edit user defined code:    Calls the edit genetic code dialog box.
Notes:

This function applies to type 'N' (nucleic acid) sequences    only.    If you attempt to 
apply this fuction to other sequence types, an error message will be displayed.

 If no data in the current sequence is selected, translation begins at the current 
position and continues to the end of the sequence.

 If data in the current sequence is selected, translation extends along the length of 
the selection only.
______________
Related topics:
Translate all
Selecting data



Translate all

This function creates six new protein sequences, one for each reading frame.    The forward 
translation products are shown above the translated sequence, and are give names starting 
with a plus sign.    The reverse translation products are shown below the translated 
sequence, and are give names starting with a minus sign.
To translate all six frames:

1. Posistion the caret in the sequence you wish to translate.
2. Select 'Translate all' from the sequence menu..

Setting the genetic code:
You may choose to use the universal genetic code or a user defined genetic code that you 
can edit.    To set genetic code options, select Editor options from the Options menu, then 
choose from the following:

Universal: Use the standard genetic code

User defined: Use the user defined genetic code.

Edit user defined code:    Calls the edit genetic code dialog box.
Notes:

This function applies to type 'N' (nucleic acid) sequences    only.    If you attempt to 
apply this fuction to other sequence types, an error message will be displayed.

This function is applied to the whole sequence regardless of data selection.
______________
Related topics:
Translate in frame



Pretty display
Pretty display is intended to provide you with a flexible way of displaying the sequences in 
the editor.    When you select Pretty display, all of the sequences in the editor are included.    
So if you want to display just one sequence, you will have to delete all the other open 
sequences before you select pretty display.
How to:    To display your sequences with pretty display:

1. Make sure that only the sequences you want to display are open in the editor.
2. Select Pretty display from the sequence menu

To set display options: 
1. Select Pretty display options from the options menu.    This calls the Pretty display 
options dialog box.
2. Choose from the following options:

Line length:    The number of characters to display on each line.

Name field:    The number of characters from the sequence names to display. For 
example, if the Name field is set to 8, only the first 8 characters of each sequences name is 
displayed.

Vert. spaces:    The number of veritical spaces to place between groups of lines.

Space every:    Displays the sequence in groups of n characters.    For example, if 
Space every is set to 10, a space in inserted after every 10th charater. 

Box identities:    Draws boxes around each sequence character that is identical to
the character in the same position in the first sequence.    Note that this option only applies 
to the display of more than one sequence.    The Space every option is ignored when Box 
identities is selected

Numbers:    Determines the placement of sequence numbering.    The options are:
None:    No numbers are displayed.
Left:    Numbers are displayed to the left of the sequence.    Note: The 

sequence names are not displayed when this option is choosen.
Right:    Numbers are displayed to the right of the sequence.
Top:    Numbers are displayed above the sequence.
Bottom:    Numbers are displayed below the sequence.



4. Press the OK button

Notes:

This function is applied to all sequences currently open in the editor.

 The start and end point values are not used for this function.

You can copy from the pretty display window.    Position the mouse at the point you 
want to start at.    Click the left mouse button and hold it down while you move the mouse.    
This will draw a box.    Release the left button and select copy from the edit menu.    You can 
then paste the selection into your drawing program or word processor.



Pattern Search
Pattern Search alows you to search both nucleotide and amino acid sequences for patterns 
using the prosite data base syntax.    The results of the search are displayed as a map in the 
graph window and as a table in the data window.    In addition, the sites are highlighted on 
the sequence in the editor.

To search for a pattern:
1. Position the caret in the sequence you wish to search.
2. Select Pattern search from the Edit menu.
3. Enter a pattern in the Pattern search dialog box.    
4. Press the OK button.

Pattern syntax:

Pattern search uses the prosite data base pattern syntax as specified in the prosite 
database (Bairoch A., Bucher P., PROSITE: recent developments. Nucleic Acids Res. 
22:3583-3589(1994)).

The patterns are described using the following conventions:

The standard IUPAC one-letter codes for the amino acids are used.

The symbol `x' is used for a position where any amino acid is accepted.

Ambiguities are    indicated by    listing the acceptable amino acids for a given 
position,    between square    parentheses `[    ]'. For example: [ALT] stands for Ala or Leu or 
Thr.

Ambiguities are    also indicated    by listing between a pair of curly brackets `{    }' 
the    amino acids that are not accepted at a given position. For example: {AM} stands for 
any amino acid except Ala and Met.

Each element in a pattern is separated from its neighbor by a `-'.

Repetition of    an element    of the pattern can be indicated by following that 
element    with a    numerical value    or    a    numerical    range    between parenthesis. 
Examples: x(3) corresponds to x-x-x, x(2,4) corresponds to x-x or x-x-x or x-x-x-x.



When a    pattern is    restricted to    either the    N- or    C-terminal    of    a sequence, 
that    pattern either starts with a `<' symbol or respectively ends with a `>' symbol.

Examples:

[AC]-x-V-x(4)-{ED}.

This pattern    is translated    as: [Ala or Cys]-any-Val-any-any-any-any-{any but Glu or 
Asp}

<A-x-[ST](2)-x(0,1)-V.

This pattern,    which must    be in    the N-terminal of the sequence (`<'), is translated as: 
Ala-any-[Ser or Thr]-[Ser or Thr]-(any or none)-Val



Matching two sequences
Matching is used to identify data points in a sequence that are identical to the same data 
points at the same position in the sequence imediately above it.    Identical elements are 
connected by a vertical line.

For example, matching the sequence ATGACGA with the sequence ATGGATA results in a 
match that looks like this:

To match data from the current sequence with the sequence above, select 'Match' from the 
sequence menu.

Shortcuts:

 Press the 'Match' icon on the tool bar.

 Type the keys <CTRL>-M

Notes:

 If no data in the current sequence is selected, the match extends from the current 
position to the end of the current sequence or the end of the sequence above, whichever is 
smaller.

 If data in the current sequence is selected, the match extends along the length of 
the selection only.

 If there is no sequence above the current sequence, or if there are too many 
sequences open, an error message is displayed.
______________
Related topics:
Selecting data



Dialog boxes
Edit genetic code
Editor options
File open
File save
Find
Fonts
Insert spaces
Pretty display options dialog box
Pattern search
Print setup
Print
Sequence options
Select sequence



Edit genetic code dialog box

This dialog box is used to edit the user defined genetic code:

Enter code:
Codon:    Displays the current codon.
Three letter code:    Enter the three letter code for the residue you wish to associate 
with the current codon.
One letter code:    Enter the one letter code for the residue    you wish to associate with 
the current codon.
Scroll bar: Sets the current codon.    Use the scroll bar to scroll through the availble 
codons.

Codes:
Lists the standard three and one letter codes for reference purposes.

______________
Related topics:
Editor options
Translate in frame
Translate all



Editor options dialog box

Use this dialog box to set editor options to change the appearance of the editor, or to 
determine what genetic code is used in the translation of nucleic acid sequences.    The 
editor options are:

Lines:
Line length:    Sets the number of characters displayed on each line.    The line length 
must be an even mutlple of 10, and may not be greater than 250.
Name field width:    Sets the number of characters displayed of the name of each 
sequence.    The name field width may be any number bewteen 0 and 16.    If the name 
field width is less than the number of characters in the name of a sequence, the name is 
truncated.

Non-scrolling position line:
Always on:    Non-scrolling position line    displayed at all times.
Always off:    Non-scrolling position line of at all times.
On when screen full:    Non-scrolling position line    line displayed only when there are 
too many sequences to fit on the screen.

Genetic code:
Universal:    Use the universal genetic code for translation of DNA sequences.
User defined:    Use the user defined genetic code for translation of DNA sequences.
Edit user defined code:    Calls the edit genetic code dialog box.    Alows you to edit the



genetic code used when the user defined option is selected. 

______________
Related topics:
Editor options



File open dialog box
This dialog box alows you to specify the name and path of a file to open.

File Name
Type or select the filename you want to open.

Files list
This box lists files with the extension you select in the List Files Of Type box.    Click once 
on a file name in this box to place the file in the file name box.    Click twice to open the 
file.
Note: To see a list of files with a particular extension, type an asterisk (*), a period, and 
the three-character extension in the File name box. For example, if you want to see all 
files with a .TXT extension in a directory, type *.txt.

List Files Of Type
Select the type of file you want to open.

Drives
Select the drive that has the file that you want to open.

Directories
Select the directory that has the file that you want to open.

OK button:    Opens the file in the file name box.    If the file name in the name box is not 
complete, the OK button is ignored.



Cancel button:    Closes the dialog box without opening the file.
______________
Related topics:
Opening an existing document
Importing a sequence



Pretty display options dialog box

Title:
Sets the title displayed at the top of the pretty display window.

Line length:
The number of characters to display on each line.

Name field:
The number of characters from the sequence names to display. For example, if the 
Name field is set to 8, only the first 8 characters of each sequences name is 
displayed.

Vert. spaces:    
The number of veritical spaces to place between groups of lines.

Space every:    
Displays the sequence in groups of n characters.    For example, if Space every is set 
to 10, a space in inserted after every 10th charater. 

Box identities:    
Draws boxes around each sequence character that is identical to the character in the 
same position in the first sequence.    Note that this option only applies to the display 
of more than one sequence.    The Space every option is ignored when Box identities 
is selected

Numbers:    



Determines the placement of sequence numbering.    The options are:
None:    No numbers are displayed.
Left:    Numbers are displayed to the left of the sequence.    Note: The sequence 
names are not displayed when this option is choosen.
Right:    Numbers are displayed to the right of the sequence.
Top:    Numbers are displayed above the sequence.
Bottom:    Numbers are displayed below the sequence.



File save dialog box
This dialog box alows you to specify the name and path of a file to save.

File Name
Type or select the filename you want to save.

Files list
This box lists files with the extension you select in the List Files Of Type box.    Click once 
on a file name in this box to place the file in the file name box.    Click twice to save the 
file.
Note: To see a list of files with a particular extension, type an asterisk (*), a period, and 
the three-character extension in the File name box. For example, if you want to see all 
files with a .TXT extension in a directory, type *.txt.

List Files Of Type
Select the format that you want the file to be saved under.

Drives
Select the drive that you want the file to be saved to.

Directories
Select the directory that you want the file to be saved to.

OK button



Saves the file in the file name box.    If the file name in the name box is not complete, the
OK button is ignored.

Cancel button
Closes the dialog box without opening the file.

______________
Related topics:
Exporting a sequence
Saving a document



Fonts dialog box
This dialog box alows you to set a font for a given window or for the title displayed in the 
graph window.

Font
The name of the font.    You can type the name in the font edit box, or you can select a 
font from the font list box by clicking on it with the left mouse button.

Font Style
The style of the font.    You can type the style in the font style edit box, or you can select 
a style from the style list box by clicking on it with the left mouse button.

Size
The size of the font.    You can type the size in the font size edit box, or you can select a 
size from the font size list box by clicking on it with the left mouse button.

Sample
Displays a sample of what your selected font will look like.

______________
Related topics:
Selecting fonts



Pattern search dialog box
This dialog box alows you to enter the pattern you wish to search the current sequence with.

Pattern:    Enter the search pattern using the prosite data base syntax (see Pattern search).  
To choose a    recently used pattern, press the down arrow, select the desired pattern with 
the mouse and press OK.

______________
Related topics:
Pattern search.



Select sequence dialog box
This dialog box alows you to select a sequence to be imported from a library.

Sequence information:
Lib:    Name of the library file.
Format:    Format of the library file.
Number of sequences:    Number of sequences in the file.
Selected seq:    The currently selected sequence.

Sequence list:
Lists the sequences in the library.    To select a sequence to import, scroll the list until the 
desired sequence name is visible, click on the sequence name with the mouse and press 
OK.

______________
Related topics:
Importing sequences.



Print dialog box
This dialog sets basic printer options.

Printer
Displays the currently selected printer.

Print Range
All: Print the whole document, table or graph.
Selection:    Print the selected parts of the document only.
Pages:    Print the specified pages only.

Print Quality
Sets the printer resolution.

Copies
Sets the number of copies to print.

Collate copies
Sort copies.

Setup
Calls the Print setup dialog box.    Selects the printer and sets printer options.

______________
Related topics:
Printing
Print setup dialog box.



Print setup
Use this dialog box to specify printer settings for your printer.

Printer
Default Printer:    Use the printer that you defined as the default printer from the 
windows control panel.
Specific Printer:    Select a printer other than the default.    Note: you must install 
printers from the windows control panel before you can select them with this dialog box.

Orientation 
Portrait:    Print using the portrait orientation (height is greater than width).
Landscape:    Print using the landscape orientation (height is greater than width).

Paper
Size:    Select the size of the paper used.
Source: Select the source of the paper for printers that use more than one source.

Options
Specify other, printer specific options.

______________
Related topics:
Print dialog box
Printing



Sequence options
This dialog box alows you to change options that apply to the current sequence only.

Name
Displays the sequence name.    You can enter a name of up to 15 characters.    Note that 
the name may be truncated on the screen if the name field width is set to less than 15.

Number
Displays the sequence postion on the screen.    Entering a new postion will cause the 
sequence postion to change.

Sequence type
To set the sequence type, click on the option you want.

______________
Related topics:
Sequence options: name,    type, and number



Insert spaces
This dialog box alows you to insert spaces into a sequence in a regular pattern.    Any 
existing spaces are first removed from the sequence before the new spacing is applied.

Insertion interval
Displays how often spaces are to be inserted.

Number of spaces:
Displays how many spaces are to be inserted.

Example:      If you enter an insertion interval of three, and Number of spaces of two, two 
spaces will be inserted between every third character.

______________
Related topics:
Inserting spaces into a sequence
Removing spaces from a sequence



Find
Use this command to search for specified text in the current sequence.

Find What
Type the text you want to find, or paste it from the Clipboard (CTRL+V).

Match Case
Select this option to find only those occurrences with the combination of uppercase and 
lowercase letters specified in the Find What box.

Direction
Up:    Searches from the insertion point or the end of the selection to the beginning of 
sequence.
Down:    Searches from the insertion point or the beginning of the selection to the end of 
the sequence.
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Registration
Vised is ShareWare

Vised is "ShareWare".    This entitles you, the customer, to try out the software for up to 
30 days without obligation to pay for it.

Shareware (non-registered) Vised is a "full" version.    This means that the same 
capabilities available in the registered software are present in the non-registered 
software.    In fact, the non-registered software includes a bonus feature - the shareware 
nag box

If you use Vised beyond the 30 days, you should register it.    Registration entitles you to 
free upgrades to the software, which is nice.    

How Much Does It Cost To Register?
Registering Vised costs you only $30.00 US.    If you are part of an organization and wish 
to use several copies, greatly reduced site licensing rates are also available.

How To Register
To register, please print out a registration form and send it to:

Ken Peters
487, Aquila Place
Parksville, BC
Canada.
V9P 1C1

Before you register, please take a look at the Licensing section of this help file.

Unlocking the Software
You will receive a notification of registration    which contains your personal registration 
name and number.

First, bring up the Reigistration Dialog by first invoking About dialog box, then clicking on
the Register button.

Enter your name in the registration dialog.    Be sure to type your name exactly as it 
appears in your notification, as capitalization, spaces and punctuation are all taken into 
account when computing your registration number.

Now enter your personal registration number, and select Register    If all is well, Vised will
respond with a message thanking you for your registration.    Otherwise Vised will 
complain that your name and number don't match, and you will have to correct the 
information.





Software Distribution and Licensing 
Information
Distribution

This shareware software may be freely distributed, provided that:

(1) Such distribution includes only the original archive.    You may not alter, delete or add 
any files in the distribution archive.

(2) The distrubution does not include a registration number.    In particular, you may not 
distrubute a registered version of Vised.
(3)  No money is charged to the person receiving the software, beyond reasonable cost 
of packaging and other overhead.

License
By receiving and/or using Vised, you accept the following Evaluation and Registered User
Agreement.    This agreement is a binding legal agreement.    If you do not intend to honor
this agreement, remove Vised from your computer now.

Evaluation (Unregistered) and Registered User Agreement
You may evaluate the Shareware program for maximum of thirty calendar days, after 
which you must register the program, or remove the software from your computer.    

All parts of Vised are copyright protected.    No program, code, part, image, video clip, 
audio sample, text or computer generated sequence of images may be copied or used in 
any way by the user except as intended within the bounds of the single user program.

The evaluator/user/buyer/owner of Vised will indemnify, hold harmless, and defend the 
author of Vised against lawsuits, claims, costs associated with defense or accusations 
that result from the use of Vised software. 
 
The author of    Vised is not responsible for any damages whatsoever, including loss of 
information, interruption of business, personal injury and/or any damage or 
consequential damage without limitation, incurred before, during or after the use of our 
products.    Our entire liability, without exception, is limited to the customers' 
reimbursement of the purchase price of the software.

Each registered copy of Vised may be used in only one single location.    Use of the 
software means that you have loaded the program and run it or have installed the 
program onto a computer.    If you install registered copies of the software onto a multi-
user platform or network, each and every individual user of the software must be 
registered separately.

You may make one copy of the registered software for backup purposes, providing you 
only have one copy installed on one computer.



The sale of and or distribution of registered copies of this software is strictly forbidden.    
It is a violation of this agreement to loan, rent, lease, borrow, or transfer the use of 
registered copies Vised.



Credits
Vised uses sequence import and export functions from Readseq (c) 1990 by Don Gilbert.    
Thank you, Don for making those functions public!
The multi-sequence editor format used by Vised was inspired by the DOS program, esee, by 
Eric Cabot.



About Vised

About the author:
I have a Ph.D. in genetics from the University of British Columbia.    About Three years
ago, I decided to stay home with my kids.    In order to keep myself from going crazy, I
taught myself how to program and wrote this and several other pieces of software.    I 
am open to job offers...

How to contact the author:
e-mail:    kpeters@qb.island.net

Version history:
Version 1.0 - May 1996.

-Initial release.
Version 1.0a - July 1996.

-Fixed file open bug that caused vised to crash when the file contained too many 
sequences.

-Increased number of sequences from 20 to 30.

Version 1.1 - September, 1996
-Fixed resource leak in pretty display.

-Fixed bug that caused loss of pretty display title on setting window focus.

-Increased number of sequences to 200.

-Changed scrolling from block-by-block to line-by-line so that more sequences 
than would fit on the screen at one time could be displayed.

-Added a non-scrolling position line to aid in navigation when more than a screen 
full of sequences are open.

-Added navigation buttons and keyboard shortcuts.
Upcoming:

Version 2.0 will add the following features:
- User-definable color display of bases.
- Support for standard codon tables.
- Option to turn off line-wrap so that sequences can be displayed on one long line.
- Support for third party applications.



Registration form
Please print this form, fill it out and send it to:

         Vised
         487 Aquila Place
         Parksville, BC
         Canada
         V9P 1C1

Name___________________________________________ Date_______________

Company________________________________________ Phone______________
                     
Street_________________________________________ FAX________________

City__________________ Country_________ ZIP/Postal code____________

Email___________________________________________________________ ___

 

                ALL AMOUNTS ARE UNITED STATES DOLLARS

SINGLE USER LICENSE:    @ $30.00                          = _______

SITE LICENSE:   Must supply a proper business name.
   3 to  9 computers    @ $21.00 each X ____units         = _______
  10 to 29 computers ...@ $19.00 each X ____units         = _______
  30 to 99 computers    @ $15.00 each X ____units         = _______
 100 &  up computers    @ $11.00 each X ____units         = _______

        Total (US funds only)                               _______

Method of payment:  Cheque__           Money order__ 
                    Purchase order__   Credit card__

Purchase order number: (universities only)_________________________

Credit card:

Mastercard__  VISA__

Name exactly as on credit card ___________________________________

Card Number________________________________  Exp.Date_____________

Signature_________________________________________________________




